RefWorks is a web-based tool that helps you manage citations, create bibliographies, and import references from databases. It can convert stored citations into formatted bibliographies.

This video shows why we bother using something like RefWorks:
http://www.tubechop.com/watch/217234
(This 1-minute video shows exactly HOW RefWorks makes academic research and writing easier!)

Handout covers (broadly):
- Getting references INTO RefWorks (collecting references while doing research)
- Getting references OUT of RefWorks (inserting citations into a Word document)
- Organizing research into folders
- Sharing with others
- Creating annotated bibliographies
- Using the library while writing (searching)

For more information on using RefWorks at TCNJ, consult our research guide on the topic:
http://libguides.tcnj.edu/RefWorks
This page also includes contact information for TCNJ librarians who can help you with RefWorks.

You’ve already collected references in another program? Check out this page to make the switch to RefWorks:
http://www.refworks.com/refworks/help/Exporting_from_Bibliographic_Programs_and_Importing_into_RefWorks.htm

Why RefWorks over its competitors?:
RefWorks is a cloud-based tool that allows users to view, edit, and add to their personal libraries from any internet-connected computer in the world.
It doesn’t live on one computer; it lives on almost ANY computer.

Is RefWorks magic? (An important caveat about checking your work)
Well, it does help the research process so much that it sometimes feels like magic. But it’s important to remember that you’ll still need to proofread your citations and works-cited lists. RefWorks uses just the information you provide, so it’s a classic garbage-in-garbage-out situation.

RefWorks helps a lot, but not with everything!
You’ll still need to know the broader requirements for citation styles (e.g., line spacing, page margins, heading styles). For APA, MLA, and Chicago styles, try: https://owl.english.purdue.edu/owl/ (Along with very clear style guides, includes very helpful sample papers).

Handout by:
John T. Oliver, Information Literacy Librarian, The College of New Jersey Library, oliverj@tcnj.edu
Getting Started:

You must create an account in order to start using RefWorks.

1. Go to RefWorks: [http://library.pages.tcnj.edu/search-tools/databases-a-z/refworks/](http://library.pages.tcnj.edu/search-tools/databases-a-z/refworks/)
   (If off campus, you may be prompted for the TCNJ group code: RWCNewJersey)
2. Click “Sign up for a New Account”
3. Complete the short set of questions, and click “Create Account”
4. Now you’ve got an empty vessel to receive all the brilliant research you want to save!

Getting references INto RefWorks (collecting them while doing research)

There are a few ways to add references to RefWorks. Here are the 3 that we will cover:
- Direct Export
- RefGrab-It
- Add a reference manually

Each of these has its unique and necessary uses, so any RefWorks user should really learn all 3!
Direct export from database

(STEPS: REFWORKS LOGIN > SEARCH DATABASE > SELECT ITEMS > EXPORT)
When doing searches in databases, it is best to use direct export from the research database to RefWorks.

The particular steps for this process are straightforward, but they will vary slightly based on your particular set up, including several factors: which academic database you’re using, plus which web browser and operating system you use. But here’s the gist:

1. Double check that you are logged into RefWorks.
2. Launch an academic research database.
   (Accessible from the TCNJ Library, at http://library.pages.tcnj.edu/search-tools/articles/)
3. Conduct your search as you normally would.
4. Identify items of interest. (Click corresponding checkboxes or “Add to Folder”/“Add to List” icons).
5. Click **Export** (or Save)

**The word “Export” is key for this step. You should see it in the margins (near the top or bottom or near the far left or right side)**

**If you don’t see the word “Export” written anywhere, you’ll need to add items to a folder or a list, then go to the folder or list, THEN export from that folder or list**
6. Be sure to choose RefWorks (if given the choice between citation software options)

7. Check that your export was successful. Look at your web browser and check that it is showing something like this:
RefGrab-It

(STEPS, AFTER PROPER INSTALLATION: REFWORKS LOGIN > SEARCH WEBSITE > CLICK RefGrab-It)

RefGrab-It is a tool that you can add to your web browser in order to grab any citation information found on the webpages you use. It’s well suited for grabbing citation information about webpages. It’s also helpful on sites like Amazon, Google Scholar, and PubMed, but it is also the easiest way to grab accurate citation information on books held at TCNJ Library. (Also try it when you’re reading an article in The New York Times and want to quickly grab the citation info).

The RefGrab-It browser bookmarklet works with the Internet Explorer, Mozilla Firefox, and Google Chrome browsers. (And is compatible for Windows and Mac machines). Safari browsers does not work well with the RefGrab-It bookmarklet.

Installing RefGrab-It is a basic drag-and-drop procedure that’s shown in the screenshot below.

1. Log into your RefWorks account
2. Click or hover your mouse pointer over “Tools”
3. Click “RefGrab-It”
4. Look near the bottom of the window that pops up.
   Look for the instructions for the “RefGrab-It Bookmarklet”
5. Click and hold down the mouse button on the piece of text that reads “RefGrab-It”, and while holding down the mouse button drag the piece of text to the top of the browser window, and THEN drop it in the bookmarks toolbar section (just below the URL bar).
A successful installation of RefGrab-It:

Now, whenever you’re on a webpage that has references you want to grab, just click RefGrab-It. You’ll see a screen that lets you choose which references to add:

RefGrab-It works for some webpages that put references in a giant list (like Google Scholar, above, or in PubMed, below on next page).
Using RefGrab-It in PubMed:

However, RefGrab-It generally works best when you’re looking at the detailed view for one particular item. For example:

RefGrab-It while viewing an individual article in The New York Times:
RefGrab-It while viewing an individual book in TCNJ Library’s catalog:

RefGrab-It while viewing an individual book in Amazon:
Manual entry
[Especially useful for book chapters, reports, unconventional reference types]

1. Click or hover your mouse pointer over the “References” menu, then click “Add New”

2. Be sure to choose the Ref Type (usually a webpage or a book chapter or report).
3. Choose the citation style you plan to use
4. Enter all the information required for the style you’ve chosen.

**A few tips about entering references manually:**
1. Authors should be entered in this very specific format: Lastname,Firstname
   [NOTE: There should be no spaces between the last name and first name.]
2. Multiple authors should be entered like this: Franklin,Ben;Ross,Betty
   [Again, no spaces between last name and first name]
Attaching PDFs (to create a personal library)
1. Click the “Edit” icon:

3. Click through your computer to find the right file.
4. Click “Add attachment,” then click “Save Reference.”

5. You can now close the popup window. (Your PDF should be attached).
Getting references OUT of RefWorks (inserting refs into Word document)
This process depends on a special RefWorks program called Write-N-Cite

Installing Write-N-Cite:
1. Login to your RefWorks account
2. Click or hover your mouse pointer over “Tools”
3. Click Write-N-Cite
4. Follow whatever download instructions apply to your particular set up (Windows or Mac).
5. If you have any issues with the installation, look for help links that read “Install Information,” or feel free to contact TCNJ librarians.

Launching Write-N-Cite
1. Open the Word document you will be inserting reference(s) into.
2. Open a web browser and log into your RefWorks account.
3. Open the Write-N-Cite application.
   (On Windows machines, you will most likely have a Write-N-Cite shortcut icon on your desktop. On Mac machines, you will most likely find Write-N-Cite as a toolbar under the “View” menu.
4. You will be asked to log in to Write-N-Cite:

![RefWorks User Login for College of New Jersey](image)
5. After you log in, you will see all your references in the Write-N-Cite window:

This Write-N-Cite view may become unwieldy the more that you add to RefWorks. But there are two tools that are helpful for navigating your own RefWorks library: **View >> Folder** and "**Search RefWorks**"
Inserting references into a Word document:

1. Go to your Word document. Put the cursor where you want the in-text citation to go. (We will worry about the end-of-document bibliography in a moment).
2. Go to Write-N-Cite, then click the word “Cite” for any reference that you want to add to your document. This will insert a temporary placeholder for the in-text citation.

3. Continue with your writing. When you want to insert additional references, repeat steps 1 and 2 immediately above.
4. For multiple citations in the same location, just click the word “Cite” for each of the citations you wish to add:
Generating your end-of-document reference list (i.e., your bibliography):
1. Go to Write-N-Cite.
2. Click “Bibliography”

3. Choose the citation style (e.g., APA, MLA, Chicago). Then, click “Create Bibliography”
Get organized!
Starting, adding, and viewing folders.

Take note: For some of the sharing and organizing functions, you will need to click the “Organize & Share Folders” tab:

1. Create a new folder: Click the “New Folder” icon
2. Choose a name for your new folder, then click **Create**.

![Image of RefWorks interface showing the creation of a new folder.](image)

*Add a few items to this new folder.*

3. Click the References tab

![Image of RefWorks interface with the References tab highlighted.](image)

4. Click the checkboxes for several items.
5. Click or hover your mouse pointer over this folder icon
6. Select the folder where you want to store these items.
Get together!
Sharing references with collaborators

There are two ways to easily share your research via RefWorks: 1) using RefShare or 2) creating a new account for the group.

**RefShare** is easy and allows you to share materials while also logging in with your individual account. (In other words, it allows you to behave as you normally would). The disadvantage is that RefShare permits one-way sharing only: You will be able to tell other people what you’ve added to a shared folder or folders, but they won’t be able to add anything to it. So, this sets up a situation in which there is a creator role and a viewer role. (And viewers can do only that: “view”).

**Creating a new group account** allows multiple people to add references and research efforts to one shared place, in a way much more in line with how we typically think of full collaboration. Each participant is an equal player in the creation and maintenance of the shared space. The disadvantage is that it requires you (and any collaborators) to remember the extra username and password. For instructions on this option, see the create-a-new-account instructions near the beginning of this document. (Remember: You can create as many accounts as you like).

Sharing via RefShare:
1. Click the “Organize & Share Folders” tab.
2. Click the icon, and you will be asked to confirm that you wish to share the folder. (On the screen that follows, try some of the different sharing options provided. See what you prefer). Close the “Shared Folder Options” popup window when you’re finished.

3. When you’re ready to email the shared folder to someone, click the icon, then select “Email this share”
Creating annotated bibliographies:
Summarizing and analyzing research literature in an annotated bibliography can help students build an understanding of a topic. RefWorks makes it easy to create these.

One straightforward way (among several) is to simply add one’s annotations to the abstract field, then choose a citation style that displays the abstract field when it generates the bibliography. This can be done without any customization with APA and MLA style.

The step-by-step procedure:
1. Login to RefWorks
2. Collect relevant references into a folder in RefWorks.
   (See instructions above, on creating folders and adding to them)
3. Open that special folder (folder links are in RefWorks’ right margin)
4. Go through each item, adding appropriate annotations to the abstract field. (If the article already has an abstract (supplied by the publisher), you should first copy and paste that text into the adjacent “Notes” field.)
5. Click “Bibliography,” then “Output Style Manager”
6. Search for the word annotated
7. For one or more of these annotated styles, click the right-facing arrow.
   This will add the selected style(s) to the short list of styles that Write-N-Cite will display while you’re writing.

Choose an “Annotated with Abstracts” style, then click the right-facing arrow
8. Launch Write-N-Cite  
    (You will need to log in. If off-campus, you will need 
    to enter the group code **RWCNewJersey** ) 
9. Click the word “Cite” for any reference that you want to add to your document. This will insert 
    a temporary placeholder for the in-text citation.

![Image of Write-N-Cite interface]

{{7 Aarts,H. 1997;5 Bannan-Ritland,Brenda 2003;4 Bell,P. 2004;}}

10. In Write-N-Cite, click “Bibliography”

![Image of Write-N-Cite interface with bibliography details]

{{7 Aarts,H. 1997;5 Bannan-Ritland,Brenda 2003;4 Bell,P. 2004;}}
11. Choose one of the “annotated with abstracts” output styles you just added. Then, click “Create Bibliography”

{{(Aarts, H., 1997; Bannan-Ritland, Brenda 2003; Bell, P. 2004;)}}

12. Done!
Using RefWorks while writing (searching your own library):
If you know that a particular word, phrase, or name occurs in one of the references or documents you’ve stored in RefWorks, you can quickly find it.

You can search your RefWorks library in either of 2 modes: References only or References and attachments.

Click the paper clip icon next to the search box to toggle between these 2 modes. Hover your mouse pointer over the icon to see which mode you’re in.

References only:
References and attachments:
Hands-on exercises:
If you can do these exercises, you have enough skill and understanding to hit the ground running with RefWorks. (There’s more to it than this, but this will get you started.)
If you’re confused about how to complete these exercises, please feel free to contact me for additional help: oliverj@tcnj.edu

1. Practice “Direct Export” (LOGIN > SEARCH > SELECT > EXPORT)
   Use either PsycInfo or Academic Search Premier (also sometimes called EBSCOhost) to find 2-3 citations that you might cite in your paper.
   Go through the steps necessary to save those references in your RefWorks library.

2. RefGrab-It, Part I
   First, install the RefGrab-It plugin on the Firefox, Chrome, or Internet Explorer browser.
   Search PubMed and find 2-3 citations that you might cite in your paper.
   Go through the steps necessary to save those references in your RefWorks library.

3. RefGrab-It, Part II
   Use either Amazon.com or The New York Times to find something you want to save in your RefWorks library.

4. Insert an in-text citation/reference into your paper
   In a draft document in Word, insert a reference from your RefWorks library.

5. Add a end-of-document bibliography into your paper
   In a draft document in Word, insert a formatted bibliography. Use a Word document to which you have added in-text citations from your RefWorks library.